COMP 1004
Introduction to Computers for the Sciences

Spreadsheets
Microsoft Excel

Notes were produced by Sylvain Pitre
a grad student in the School Of Computer Science. They have been slightly modified.
What is a Spreadsheet?

- A spreadsheet is a grid that organizes data into columns and rows.
- Often financial information.
- People can insert formulas to work with the data.
- For example, there is a particular icon that has a formula to sum up numbers that are given.
- Information can also be sorted and filtered.
- People use spreadsheet programs to learn about different kinds of things and to make decisions.
Paper Ledger v/s Spreadsheet

- A spreadsheet is the computer equivalent of a paper ledger sheet.
- It consists of a grid made from columns and rows.
- It is an environment that can make number manipulation easy and somewhat painless.
Paper Ledger v/s Spreadsheet (2)

• The math that goes on behind the scenes on the paper ledger can be overwhelming.
• If you change the interest rate, you will have to start the math all over again (from scratch).
• The nice thing about using a computer and spreadsheet is that you can experiment with numbers without having to REDO all the calculations.

1/19/2015

COMP1001A - Chapter 8: Introduction to Microsoft Excel
Paper Ledger v/s Spreadsheet (3)

• Spreadsheets can be very valuable tools in business and at home.
• We’ll see all the different uses it can have and why it is important to learn to use a spreadsheet.
Different Spreadsheet Software

• There are many different spreadsheet software available on the market:
  – OpenOffice.org Calc (free, part of OpenOffice.org)
  – Apple Numbers ‘09 (part of iWork ’09)
  – Microsoft Excel 2007 (part of Office 2007, installed in the SCS labs)
  – Corel Quattro Pro
  – Lotus 1-2-3 (old, now called IBM Lotus Symphony Spreadsheets)
OpenOffice.org Calc (in Linux)
Apple Numbers ‘09 (on Mac OSX)
Microsoft Excel 2007 (in Vista)
Microsoft Excel 2008 (on Mac OSX)
Spreadsheet Software

• All spreadsheet software share basic look and functionality:
  – rows and columns
  – insert text, numbers
  – apply formulae to values (sum, average, ...)
Microsoft Excel

• A spreadsheet application written and distributed by Microsoft
• Overwhelmingly the dominant spreadsheet application
• Features
  – calculation
  – graphing tools
  – pivot tables
  – macro programming language called VBA (Visual Basic for Applications)
Microsoft Excel: History

• Microsoft originally marketed a spreadsheet program called Multiplan in 1982.
• The first version of Excel was released for the Mac in 1985.
• The first Windows version (numbered 2.05 to line-up with the Mac and bundled with a run-time Windows environment) was released in November 1987.
Excel 2.1 for Windows

### ANNUAL.XLS

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Annual Summary, 1984-1986</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Sales:</td>
<td>1984</td>
<td>1985</td>
<td>1986</td>
</tr>
<tr>
<td>3</td>
<td>Widgets</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Cogs</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Total sales</td>
<td>$122,684</td>
<td>$121,408</td>
<td>$135,234</td>
</tr>
<tr>
<td>6</td>
<td>Expenses:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>R &amp; D</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Mktg.</td>
<td>$53,463</td>
<td>$48,398</td>
<td>$53,279</td>
</tr>
<tr>
<td>9</td>
<td>Admin.</td>
<td>$31,298</td>
<td>$35,009</td>
<td>$36,823</td>
</tr>
<tr>
<td>10</td>
<td>Total expenses</td>
<td>$122,684</td>
<td>$121,408</td>
<td>$135,234</td>
</tr>
<tr>
<td>11</td>
<td>Operating income</td>
<td>$5,576</td>
<td>$14,963</td>
<td>$24,566</td>
</tr>
<tr>
<td>12</td>
<td>Profit margin</td>
<td>4.3%</td>
<td>11.0%</td>
<td>15.4%</td>
</tr>
</tbody>
</table>

### WEST.XLS

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Fiscal Year 1985</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Accounting Year 1985</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Fiscal Year 1986</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Sales:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Widgets</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Cogs</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Total sales</td>
<td>$242,816</td>
<td>$270,468</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Expenses:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>R &amp; D</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Mktg.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Admin.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Total expenses</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Operating income</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Profit margin</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For Help on dialog settings, press F1

[Run Application] 
- [Clipboard]
- [Control Panel]
- [Macro Translator]
- [Dialog Editor]

**OK**  **Cancel**
Things You Can Do With Excel

• Create budgets
• Work with taxes
• Record student grades
• Do Scientific modelling
Excel Element Definitions

• **Active cell:** An active is the cell you are currently working on (selected).

• **Auto sum:** A formula that will add up a column of numbers.

• **Cell Reference:** The column number and the row letter of a cell.

• **Cell:** Each individual box on the spreadsheet.

• **Column:** The vertical reference on the spreadsheet.

• **Fill:** To fill a cell with color using the paint bucket tool
Excel Element Definitions (2)

• **Fill handle:** The dot at the bottom right of each cell while it is active.
• **Filter:** The procedure to select certain information in a spreadsheet.
• **Formula:** A formula must always start with “=” signs and what the calculations for each cell.
• **Formula Bar:** Where data and formulas are typed in.
• **Graph:** A visual representation of data.
• **Grid Lines:** The horizontal and vertical lines on the spreadsheet.
Excel Element Definitions (3)

• **Row:** The horizontal reference on the spreadsheet.
• **Selecting:** To highlight a set of cells.
• **Sheet (worksheet):** One page of a workbook.
• **Sheet tabs:** Tabs that identify the worksheets in a workbook.
• **Spreadsheets:** A grid that organizes data.
• **Value:** A number that can be entered into a cell.
• **Workbook:** Many worksheets.
Opening Excel

• To open Microsoft Excel 2007, you can use the same methods that you’ve used to open Word.
  – Click on an Excel File you already have (.xls)
  – Click on an icon on the desktop if there is one.
  – Go through the Start menu to open it.
Excel Components

- Toolbars (tabs)
- Formula Bar
- Work Grid
- Status Bar
Excel Components (2)

Cell Reference
Column
Active Cell
Row
Cell
• **Formulas bar** is used to enter data (numbers, text) or formulas. We’ll see how to enter formulas a bit later.
Excel Toolbars

- Excel includes **Tabs** of toolbars instead of menus, Referred to as the **Ribbon User Interface** or “the ribbon”.
- This is a very different toolbar look from the earlier versions of office pre office 7.
- Here we see the “Home” toolbar
Excel Toolbars (2)

- The **Insert tab** in Excel allows us to insert pictures, headers, footers just like in Word, but it also allows us to insert **graphs**.
Excel Toolbars (3)

• The **Formulas tab** lets us insert different types of pre-built formulas (sum, average, maximum, etc).
Excel Toolbars (4)

• The **Data** tab lets us import data from other sources (such as a text file). It also allows us to sort data (increasing order, decreasing order).
Workbook and Worksheets

• When you start Excel, you open a file that’s called a **workbook**.
• The first workbook you open is called Book1
• By default a new workbook includes three **worksheets** (in the **sheet tab**).
• You view a worksheet by clicking its sheet tab.
Workbook and Worksheets (2)

• The **Sheet tabs** allow the user to change to a different worksheet, create a new worksheet or delete a worksheet.
Workbook and Worksheets (3)

• You can Insert, Delete, Rename, Move, Copy, worksheets as it is necessary.
  – Right-click over the sheet tab to see a popup menu.
Columns

- **Columns** go from top to bottom on the worksheet, vertically.
- After the first 26 **column headings** (A through Z), the next 26 column headings are AA through ZZ, then AAA through XFD.

One column (named “D”).
Rows

• Row headings are numbers, from 1 through 1,048,576 (in 2007 version).

• Alphabetical headings on the columns and numerical headings on the rows

One row (named “8”).
Maximum # of Rows and Columns

- The new 2007 version of Excel increased the maximum number of rows and columns in a worksheet.

<table>
<thead>
<tr>
<th>Excel Version</th>
<th>Maximum # of Columns</th>
<th>Maximum # of Rows</th>
</tr>
</thead>
<tbody>
<tr>
<td>2003 and older</td>
<td>256</td>
<td>16,385</td>
</tr>
<tr>
<td>2007</td>
<td>65,536</td>
<td>1,048,576</td>
</tr>
</tbody>
</table>

- This is important if you create an Excel file in 2007 and try to save using an older format.
Cells

• In a spreadsheet the CELL is defined as the space where a specified row and column intersect.

• Each CELL is assigned a name according to its COLUMN letter and ROW number.

• When referencing a cell, you should put the column first and the row second. Example: A1, E4.
Cells

• In each cell there may be the following types of data:
  – **text** (labels)
    • Examples: “the title”, “the car”, “budget”
    • Elements that are just text
  – **number data** (constants)
    • Examples: 5 or 3.75 or -7.4
  – **formulas** (mathematical equations that do all the work)
    • =5+3 or = 8*5+3
    • ALL formulas MUST begin with an equal sign (=).
Active Cell

• When you click on a cell it becomes “active” or selected (indicated by a black border around the cell). The row and column headers also become highlighted (orange). The cell reference also shows that cell is currently selected (A1 in this example).
Cell Example

- **B2** is the active cell
- The cell **B3** has the value 1990
- The cell **B4** has the value 2005
- The cell **C3** has the value 50
- What is the value of **C4**?
Cell Example 2

- **Column** titles are the months of the year.
- **Row** titles are the name of the budget items.
- It's a good idea to start by entering titles at the top of each column (so you and anyone else that reads your file will know what everything represents).

![Excel Sheet Example](image)
TAB and ENTER Keys

• The **TAB** key moves the selection one cell to the **right**.
• The **ENTER** key moves the selection **down** one cell.
• You can use the **arrows** as well.
• An of course the **mouse** (left-click on the cell you want to make active)
Entering Data

• Excel aligns **text** on the **left** side of cells.
• **Dates** are aligned on the **right** side of cells.
• **Numbers** in general are aligned to the **right**.
• Use a slash or a hyphen to separate the parts:
• 03/04/2005 or 3-July-2004. Excel will recognize this as a date.
• For time, enter the time, then ‘a’ or ‘p’ for am or pm. Example: 6:00 p
Entering Data (2)

• Tips:
  – You can enter today’s date automatically in a cell by pressing **Ctrl + ;**
  – Current time by pressing **Ctrl + Shift + ;**
Entering Data (3)

• To enter fractions, leave a space between the whole number and the fraction.
• examples
  – 1 1/4
  – 0 4/5 (if you don’t put the 0, then it is interpreted as the date 04-may).
Entering Data (4)

• When you have to put a list of elements excel can save you time
  – months of the year
  – days of the week
  – consecutive numbers
AutoFill

- **AutoFill**: Enter the months of the year, the days of the week, multiples of 2 or 3, or other data in a series. You type one or more entries, and then extend the series.
  
  - **Step 1**: Enter the data (example Monday, Tuesday or 1, 2, 3)
  
  - **Step 2**: Select the cells you just entered.
  
  - **Step 3**: Click and drag the Fill Handle (square dot at the bottom right of the bottom cell).
AutoFill Example

Step 1: Insert data
Step 2: Select data
Step 3: Click and drag Fill Handle
Another AutoFill Use

• You can also use AutoFill to duplicate one single value multiple times.
  – Click on one cell.
  – Click and drag the Fill Handle.

• That will copy the value of the cell in all the other cells that you have dragged the Fill Handle over.
Another AutoFill Use (2)
AutoComplete

• **AutoComplete**: If the first few letters you type in a cell match an entry you've already made in that column, Excel will fill in the remaining characters for you. Just press ENTER when you see them added.

• This works for **text** or for **text with numbers**. It does **not** work for numbers only, for dates, or for times.